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ABSTRAK

Perancangan komputer akuntansi merupakan langkah strategis yang
penting bagi perusahaan dalam mencapai efisiensi dan akurasi dalam
pelaporan keuangan. PT Radiv Anugrah Propertindo adalah perusahaan
entitas privat yang memastikan penyajian laporan keuangan sesuai
dengan standar akuntansi keuangan. Penelitian ini bertujuan untuk
merancang sistem akuntansi berbasis komputer menggunakan MYOB
Accounting sebagai perangkat lunak utama untuk mendukung proses
pembuatan laporan keuangan yang akurat dan sesuai standar. Analisis
yang digunakan dalam penelitian ini meliputi analisis kebutuhan, desain
sistem, implementasi dan evaluasi. Analisis kebutuhan dilakukan untuk
mengidentifikasi fitur dan fungsionalitas perangkat lunak akuntansi di
PT Radiv Anugrah Propertindo. Desain sistem  melibatkan
menggambarkan proses bisnis perusahaan dengan modul — modul MYOB
yang relevan. Implementasi meliputi instalansi perangkat lunak, migrasi
data dari sistem lama dan pelatihan pengguna. Evaluasi dilakukan
melalui uji coba sistem dan penilaian kesesuaian laporan keuangan yang
dihasilkan dengan SAK EP (Standar Akuntansi Keuangan Entitas Privat).
Dalam pembuatan tugas akhir ini, peneliti menggunakan metode
penelitian observasi dengan pendekatan deskriptif. Adapun teknik dalam
pengumpulan data yaitu melalui studi pustaka. Berdasarkan hasil
penelitian, implementasi MYOB Accounting di PT Radiv Anugrah
Propertindo mampu meningkatkan efisiensi dan akurasi dalam proses
akuntansi serta mempermudah penyusunan laporan keuangan sesuai
dengan standar yang ditetapkan

Kata Kunci: Perancangan komputer akuntansi, MYOB Accounting,
Standar Akuntansi Keuangan Entitas Privat, laporan keuangan, PT Radiv
Anugrah Propertindo

ABSTRACT

Accounting computer design is an important strategic step for companies in
achieving efficiency and accuracy in financial reporting. PT Radiv Anugrah
Propertindo is a private entity company that ensures the presentation of
financial reports in accordance with financial accounting standards. This
study aims to design a computer-based accounting system using MYOB
Accounting as the main software to support the process of making accurate
and standardized financial reports. The analysis used in this study
includes needs analysis, system design, implementation and evaluation.
Needs analysis is carried out to identify the features and functionality of
accounting software at PT Radiv Anugrah Propertindo. System design
involves describing the company's business processes with relevant MYOB
modules. Implementation includes software installation, data migration
from the old system and user training. Evaluation is carried out through
system trials and assessment of the conformity of the resulting financial
reports with SAK EP (Private Entity Financial Accounting Standards). In
making this final assignment, the researcher used an observational
research method with a descriptive approach. The technique in collecting
data is through literature studies. Based on the research results, the
implementation of MYOB Accounting at PT Radiv Anugrah Propertindo is
able to increase efficiency and accuracy in the accounting process and
facilitate the preparation of financial reports in accordance with
established standards.
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PENDAHULUAN

Perumahan adalah satuan lingkungan tempat tinggal yang terdiri dari satu
atau lebih unit rumah. Menurut Undang - Undang Republik Indonesia Nomor 1
Tahun 2011 tentang perumahan dan kawasan pemukiman, perumahan adalah
kumpulan rumah yang berfungsi sebagai lingkungan tempat tinggal atau
lingkungan hunian yang dilengkapi dengan sarana, prasarana dan utilitas umum
sebagai hasil dari upaya pemenuhan rumah layak huni.

Kabupaten Sumedang yang terletak di Provinsi Jawa Barat, memiliki potensi
strategis yang dekat dengan kota-kota besar seperti Bandung dan Jakarta. Selain
itu, ketersediaan lahan industri yang luas di Sumedang juga menjadi daya tarik
bagi Perusahaan untuk berinvestasi. PT Radiv Anugrah Propertindo adalah
Perusahaan properti yang memanfaatkan ketersediaan lahan di Sumedang untuk
mengembangkan berbagai jenis perumahan yang sesuai dengan kebutuhan dan
daya beli masyarakat.

Pengembangan perumahan oleh PT Radiv Anugrah Propertindo memberikan
dampak positif yang besar bagi masyarakat umum untuk menyediakan tempat
tinggal yang aman, nyaman dan layak bagi keluarga serta membawa dampak
positif yang besar bagi Kabupaten Sumedang seperti, menciptakan lapangan kerja
bagi penduduk setempat dan menarik lebih banyak investor untuk berinvestasi di
Sumedang. Keberhasilan proyek - proyek ini juga menghasilkan pendapatan bagi
PT Radiv Anugrah Propertindo yang dapat meningkatkan nilai aset, memberikan
keuntungan jangka panjang dan stabilitas finansial Perusahaan.

Pendapatan PT Radiv Anugrah Propertindo sebagian besar berasal dari
penjualan unit perumahan memiliki dampak yang signifikan terhadap laporan
keuangan Perusahaan. Pendapatan ini dicatat sebagai pendapatan usaha dalam
laporan laba rugi serta diimbangi oleh biaya produksi yang mencakup biaya
pembangunan, bahan baku, tenaga kerja dan biaya operasional seperti, biaya
pemasaran, biaya administrasi dan biaya umum Perusahaan.

Setiap transaksi keuangan yang terjadi mulai dari pendapatan, biaya
produksi dan biaya operasional dicatat sesuai dengan periode penggunaannya.
Maka, dibutuhkan seorang akuntan untuk memastikan pencatatan keuangan PT
Radiv Anugrah Propertindo dilakukan dengan tepat dan laporan keuangan yang
dihasilkan dapat memberikan gambaran yang jelas tentang kinerja keuangan
Perusahaan.

Sistem pencatatan akuntansi yang digunakan oleh PT Radiv Anugrah
Propertindo saat ini masih menggunakan metode manual yang kurang efektif dan
efisien. Hal ini dapat menyebabkan kesalahan dalam pencatatan serta
meningkatkan biaya dan waktu yang dibutuhkan untuk mengelola keuangan
sedangkan pembuatan laporan keuangan yang akurat dan sesuai dengan standar
akuntansi keuangan yang berlaku merupakan hal yang sangat penting untuk
memantau kinerja keuangan Perusahaan.

Standar Akuntansi Keuangan yang berlaku di Indonesia adalah Standar
Akuntansi Keuangan (SAK) yang diterbitkan oleh Dewan Standar Akuntansi
Keuangan (DSAK). SAK ini berisi pedoman dan prinsip - prinsip yang harus diikuti
oleh Perusahaan dalam mengelola keuangan, termasuk dalam pengelolaan aset,
kewajiban, pendapatan dan biaya. Dalam rangka meningkatkan kinerja, PT Radiv
Anugrah Propertindo memerlukan sistem akuntansi yang dapat membantu dalam
pengelolaan keuangan yang lebih baik. Maka perlu dilakukan perancangan sistem
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akuntansi berdasarkan standar akuntansi keuangan yang berlaku dan terintegrasi
dengan MYOB (Mind Your Own Business) Accounting.

MYOB Accounting adalah aplikasi akuntansi yang populer digunakan oleh
Perusahaan kecil dan menengah di Indonesia. Aplikasi ini dapat membantu dalam
pengelolaan keuangan dan pembuatan laporan keuangan yang lebih baik.
Pemilihan MYOB Accounting sebagai perangkat lunak akuntansi di PT Radiv
Anugrah Propetindo didasarkan pada kebutuhan Perusahaan untuk memiliki
sistem akuntansi yang handal dan efisien.

METODE PENELITIAN

Jenis data yang digunakan oleh peneliti adalah deskriptif. Pada proses
penelitian ini, peneliti mendeskripsikan proses penyesuaian dan setup awal MYOB
Accounting serta menjelaskan cara penyusunan laporan keuangan yang sesuai
dengan kebutuhan akuntansi di PT Radiv Anugrah Propertindo.

HASIL DAN PEMBAHASAN
1. Analisis Sistem
a. Proses Transaksi Keuangan Menggunakan Sistem Lama
Proses pencatatan keuangan di PT Radiv Anugrah Propertindo saat

ini dilakukan dengan menggunakan perangkat lunak Microsoft Excel.
Adapun tahapan - tahapan yang dilakukan adalah sebagai berikut :
1) Mengumpulkan Bukti Transaksi
2) Pengajuan Pembayaran
3) Mencatat Pengeluaran Kas dan Memposting ke Buku Besar
4) Mencatat Pembelian Secara Kredit ke Dalam Buku Besar Pembantu

Utang
5) Mencatat Pengeluaran Proyek — Proyek
6) Merekap Keseluruhan Pengeluaran
7) Laporan Laba Rugi

b. Mengidentifikasi Masalah

Adapun masalah yang di hadapi PT Radiv propetindo yaitu sering
terjadinya kesalahan pencatatan dalam memasukan angka, salah ketik,
pengisian baris dan kolom, memasukan atau menyalin rumus dan
keterbatasan validasi data secara otomatis seperti, format tanggal, mata
uang dan justify.

Semakin banyak data yang dicatat juga mengakibatkan file menjadi
lambat untuk dibuka, diproses, disimpan dan sering mengalami duplikasi
data. Penumpukan penyimpanan file yang tidak tersusun dapat
menghambat pengelolaan file jika dibutuhkan dan membutuhkan waktu
yang lebih banyak untuk pelaporan bulanan karena pencatatan masih
dilakukan dengan cara manual.

Selain itu, file yang tidak di back up dengan benar memungkinkan
terjadinya kerusakan file karena terkena virus dan kerusakan perangkat
keras yang menyebabkan file hilang. Kurangnya keamanan data dalam
Microsoft Excel juga dapat meningkatkan risiko kecurangan oleh pihak yang
tidak berwenang karena dapat mengubah data tanpa terdeteksi.

Oleh karena itu, pencatatan transaksi dan pembuatan laporan keuangan
di PT Radiv Anugrah Propertindo dengan menggunakan Microsoft Excel
masih kurang efektif dan efisien.

c. Pemecahan Masalah
Untuk memecahkan permasalahan tersebut, maka diperlukan
sebuah software akuntansi berupa MYOB yang dapat mendukung kinerja
dalam pencatatan transaksi dan pembuatan laporan keuangan. Selain itu,
dengan adanya implementasi menggunakan MYOB dapat memberikan

Open Access: https://journal.ikopin.ac.id/index.php/humantech



Indra Fahmi, Muhamad Reihan Fadilla

keuntungan berupa perhitungan akuntansi yang akurat, cepat, efisien
dapat menghemat waktu dan mengurangi kesalahan manual.

2. Implementasi Sistem
a. Implementasi Sistem Pencatatan Keuangan

Implementasi sistem pencatatan keuangan dengan MYOB (Mind Your
Own Business) dapat memberikan solusi untuk mengatasi keterbatasan
pencatatan keuangan manual. Berikut adalah langkah - langkah
implementasi MYOB :
1) Membuka Program MYOB Accounting Plus V18

Dari Desktop Windows, klik dua kali ikon MYOB Accounting Plus V18.

Gambar 1. Aplikasi MYOB Accouning Plus V18

2) Membuat Data Perusahaan
Setelah program MYOB terbuka maka akan muncul tampilan menu

dibawah ini. ‘
(@ Welcome to MYOB Accounting X ‘

:‘g Open .
your company fie

Create

v
2 a new company file

D Explore

the sample company

(Vs New Accounting Plus v18

in this version

7] Exit
MYOB Accounting m

Gambar 2. Tampilan Selamat Datang MYOB Accounting Plus V18

a. Open your company file, digunakan untuk membuka file yang pernah
disimpan (myo).

b. Create a new company file, digunakan untuk membuat data
perusahaan baru.

c. Explore the sample company, digunakan untuk membuka file contoh
yang telah disediakan oleh MYOB.

d. What’s New in this version, digunakan untuk melihat fitur - fitur
baru yang terdapat pada MYOB versi ini.

e. Exit MYOB Accounting digunakan untuk mengakhiri program MYOB.

Klik Create a New Company File > Klik Next.

=
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Setelah itu akan ditampilkan informasi perusahaan seperti gambar
dibawah. Isikan data perusahaan dan cek terlebih dahulu apakah data

tersebut sudah benar.

[@ New Company File Assistant X ]

Enter your 12 digit MYOB product Senal Number
Sesial Number

Youw 7803 rumBey i ICNAT o por RIpEIANN cand and on the Ak
o o £ pleve Nov requnad v vy vevsion

Enter Inf tion about your

Introduction @
Company Information @
counting Iréarmation ©

Company Name:™ | PT RADIV ANUGRAH PROPERTINDO
ABN

Address  Chuster Mekarsan Biok G Nomor 8 Rt/Rw 08/08

Desa Mekanaya Kecamatan Sumedang Utara

Kabupaten Sumedang
Phore Number
Fax Number
Emad Address
* Reguired feld

085256395506
61,959 191 0-446 000

phradvanugahproperindo22@gmal com

Gambar 3. Company Information
Company Name : Isikan nama Perusahaan.
Address : Isikan Alamat lengkap Perusahaan.
Phone Number : Isikan nomor telepon Perusahaan.
Fax Number : Isikan nomor fax Perusahaan.
Email Address : Isikan alamat email Perusahaan.
Klik Next.

(1) Mengisi Periode Pembukuan yang akan digunakan
(& New Company File Assistant X

"o R T

Tell us about your accounting year

A finzncial year is the 12 month timedrame used to define your accounting
vear |t doss rot have to malch the calendar yes. Whal is your financisl
year?

. Curent Fnancial Year. 2024
Intreduction @

Comparp Infometin @ When does your current financial pear end?

Accounting Information @
L O
Compaty Fie

Conchuzion @

Lazt Month of Frnancial Year: | September

MYOB Accounbng requires that you choose a corwversion morth. The
conversion month iz the month in which pou choose to begin enterng
ransactions. What is your corversion morth?

Convession Month: ° Jarnsary

Most comparies uge 12 accounting peliods for repoiting puiposes. A few uge
a13h pesiod to record adustments. Which do you preler?

Numizer of Accounting Peniods: | Twelve

Gambar 4. Accounting Information

(@) Current Finansial Year : Tahun Pertama kali laporan keuangan
dihasilkan.

(b) Last Month of Financial Year : Akhir Periode Pembukuan.

(c) Conversion Month : Bulan pertama kali saldo awal akan
dimasukkan.

(d) Number of Accounting Periode : Jumlah Periode.

(e) Klik Next untuk menampilkan informasi periode akuntansi
sesuai dengan peraturan pengaturan yang sudah dilakukan.
Baca kembali informasi yang ditampilkan, jika terdapat
kesalahan klik Back untuk memperbaikinya dan jika sudah
benar Klik Next untuk tampilan berikutnya.

(2) Memilih Jenis Akun yang akan digunakan
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Build youwr accounts hst

list?

Inttodhuction @

Every company file requires an accounts kst You may either select one of
ours, of you can use your own. How would you ke to buid your accounts

Company Information @ Select the option that most fts your needs

Accourting Information @ @ | would ke to stant with one of the kst provided by MY OB Accounting

Accounts List @

| would Wke to mport 3 kst of accounts provided by my accountant after

Compary Fle © I'm done creating my company fie.

o Q | would ke to buid my own accounts list once | begin using MYOB

Accouning

accounts later

No matier whach sslection you choose, you vill be sble to add o delste

Gambar 5. Accounting List

a) I Would like to start with one of

the list provided by MYOB

Accounting : Pengguna akan menggunakan daftar akun yang

telah disediakan oleh MYOB.

b) I Would like to import to list of account provided by my
accountanct after I'm done creating my company file
Pengguna akan mengimpor daftar akun dari file lain.

c) I Would like to build my own accounts list once I begin using
MYOB : Pengguna akan membuat sendiri daftar akun secara

langsung.

d) Pilihlah jenis akun sesuai kebutuhan > Klik Next.

e)
(3) Menentukan Lokasi Penyimpanan File

Standarnya MYOB akan menyimpan file didalam drive dengan

nama file C:\myobl8ED)\(Nama

Perusahaan). Jika ingin

mengubah lokasi penyimpanan file klik Change > Klik Next.

@ New Company File Assistant

X

Create your company file

prograim

Your new company fie wil automaticaly be named the same a3 your company
name  This file vill be saved in the same location as your Accounting

C\Users\febi\DneDiive\D okumen'
MY0B PT RADIV ANUGRAH PROPERTINDO.myo

=] Cick Change ¢ you woudd lke to edi the name or locaton of
= your new Accounting company file

Chck the Nex! button to create your compary lile

Gambar 6. Company file
(4) Proses pembuatan file baru akan dilakukan oleh MYOB,

selanjutkan Klik Command Centre.
3) Menyusun Daftar Akun

Tahapan berikutnya adalah menyusun daftar akun yang akan
digunakan untuk setiap transaksi didalam laporan keuangan. Akun di

MYOB dibagi menjadi 2 (dua) bagian yaitu :

- Header : Akun yang digunakan untuk
akun detail sesuai dengan kategorinya.

- Detail : Akun yang digunakan untuk
keuangan.
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Akun yang sudah diklasifikasikan dicatat di Notepad kemudian
simpan di file explorer. Langkah selanjutnya yaitu mengimport klasifikasi
akun ke dalam MYOB. Berikut adalah langkah - langkah yang
dilakukan:

@ MYQB Accounting
File Edit Lists Command Centres Setup Reports Window Help

New Ctrl+N
Open File Ctrl+0
Command Centre E@
Print... Ctrl+P -
Print Setup... s — i L . =
Default Fonts... 5% (T -
E Pt . | =
Back Up... S Time Billing Purchases Payrall Inventary Card File
Restore...
Verify Company File... .
fy pany b Accounts List «oooeeoemaeaannns > BASlnk
Optimise Company File Tax Code List 3
Purge Journal Entries Accounts > Account Information
Start a Mew Year > lterns Budgets
Jobs )
Import Data >
Custom Lists
Export Data >
Activities m-Powered €
AccountantLink > Services
Activity Slips ( Centre
Exit Timeshests
‘ ToDolList » Find T General Journal Entries - Analysis
Disbursements >
Receipts >

Gambar 7. Langkah - Langkah Mengimport Data Akun

a. Klik File di toolbar MYOB Accounting Plus V18 > Klik Import Data >
Klik Accounts > Klik Accounts Information.

b. Setelah itu MYOB akan menampilkan pilihan untuk import data. Pilih
Update Existing Record pada Duplicate Record > Klik Continue.

c. Pilih Notepad berisi klasifikasi akun yang sudah disimpan
sebelumnya > Klik Open > Klik Match All > Klik Import.

d. Tunggu MYOB memproses import data > Klik Ok.

Setelah semua daftar akun di import, maka hasilnya akan

dimunculkan pada contoh gambar berikut :

At I Bgset I Liabity I Equity I Income I el I Expense I e I s
Accaunt Name Tupe Tar Linked Balance

[=31-0000 ASET t i
= 1-1000 ASET LANCAR Asset Rp0.00
=3 1-1100 KAS SETARA KAS Assat Rpl.0
= 11110 KasdiBank Bank N-T 0 Rp0.00
= 1-1120  Kas Setara Kas Other Aszsat N-T Rp0.00
= 11130 Kas Kecil Bank N-T 0 Rp0.00
= 11200 Piutang Usaha Accounts Receivable  |N-T ~ Rp0.00
= 11200 Insuransi Other Agset N-T Rp0.00
o 11400 Pembayaran Dimuka Other Azset N-T ~ Rp0.00
= 1-2000 ASET TETAP Asset Rp0.00
= 1-2100 PERALATAN KANTOR Asset Rp0.00
= 12110 Peralatan Kantor Other Asset N-T Rp0.00
o 1-2120  &kum. Dep. Peralatan Kantor Other Aszset N-T Rp0.00
= 1-2200 PERLENGKAPAN KANTOR Asset Rp0.00
o 1-2210  Perlengkapan Kantor Other Agset N-T Rp0.00
= 12220 Akum. Dep. Perlengkapan Kantor Other Asset N-T Rp0.00
= 1-2300 PROPERTI & BANGUNAN Asset Rp0.00
= 1-2310 PROYEK TOMOD Assat Rp0.00
= 12311 Tomo - Tanah Other Agset N-T Rp0.00
3 1-2312  Tomo - Bangunan Other Asset N-T Rp0.00
= 12313 Tomo - Akum. Dep, Other Agset N-T Rp0.00
3 1-2320 PROYEK BREBES Aaset Rp0.00
= 1-2321  Brebes - Tanah Other Agset N-T Rp0.00
(3 1-2322  Brehes - Bangunan Other Asset N-T Rp0.00
= 1-2323  Brebes - Akum. Dep, Other Agset N-T Rp0.00
= 1-2330 PROYEK KADIPATEN Asset Rp0.00
= 1-2331  Kadipaten - Tanah Other Agset N-T Rpl.00
o 1-2332  Kadipaten - Bangunan Other Aszset N-T Rp0.00
=1 1-2333  Kadipaten - &kum. Dep. Other Agset N-T Rpl.00
= 1-2400 KENDARAAN Asgset Rp0.00
=3 12410 Pickup Other Asset N-T Rp0.00
= 12411 Akum. Dep. Pickup Other Agset N-T Rp0.00
=3 12420 Dumptiuck Other Asset N-T Rip0.00
= 12421 Akum. Dep. Dumphuck, Other Agset N-T Rp0.00 =
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= 12430 Beko Other Agset N-T F\pU,UUj
] 1-2431  Akum. Dep. Beko Other Asset N-T Rp0.00
o 1-9998  Pawoll Cheque Account Bank MN-T ~ Rp0.00
= 1-8933  Elechonic Clearing Account Bark N-T ~ Fp0.00
= 2-0000 KEWAJIBAN Liability Rp0.00
5 21000 KEWAJIBAN LANCAR Liability Fp0.00
[ 21200 Utang Usaha Accounts Payable N-T ~ Rp0.00
= 21300 PAJAK Liability Rp0.00
=3 2130 Pajak Penerimaan Other Lishility N-T Fp0.00
[ 21320 Pajak Pembaparan Other Liability N-T Rp0.00
=3 2-1400 PENGGAJIAN Liability Fp0.00
[ 21410 Hutang Penggajian Other Liability N-T 0 Rp0.00
o 21500 Komisi Pegawai Other Liability N-T Rp0.00
] 21600 Komisi Pegawai Tahunan DOther Liability N-T Rp0.00
= 21700 Deposit Pelanggan Other Liability N-T ~ Rp0.00
o 21800 Kewajban Larcar Lainnya Other Liabilty N-T Ap0,00
= 2-2000 KEWAJIBAN JANGKA PANJANG Liability Rp0.00
(= 2-2400  Kewajiban.angka Panjang Lain Other Liability N-T Rp0.00
o 28333 AP Akual Persediaan Other Liahility N-T ~ F\pD,DD_I
> 3-0000 MODAL Equity Rp0.00
= 3-1000 MODAL PEMILIK Edquity Fp0.00
[ 31100 Modal PT Radiv Equity N-T Rp0.00
o 31200 Pengambilan Pribadi PT Radiv Equity N-T Rp0.00
- 38000  LabaDiahan Edquity N-T R Rp0.00
o 39000  Laba Tahun Beralan Equity MN-T ~ Rp0.00
£ 38393 Penysimbangan Historis Edquity N-T ~ Fp0.00
= 4-0000 Pendapatan Income Rp0.00
& 41000  Pendapatan Usaha Income N-T Fp0.00
= 46000 Pendapatan Ongkos Pengiiman Income N-T ~ Rp0.00
o 46000  Pendapatan Dends Income N-T v Rp0.00
o 47000 Pendapatan Lain - Lain Income N-T Fp0.00
= 5-0000 HARGA POKODK PENJUALAN Cost of Sales Rp0.00
= 51000  Harga Pokok Penjualan Cost of Sales N-T ~ Rp0.00
= 6-0000 BEBAN Expense Rp0.00
= 61000  Beban Peralatan Kantor Expense N-T Rp0.00
= E-1100  Beban Promosi Expense M-T Rp0.00
= 61200  Beban Komisi Expense N-T Fp0.00
= E-1300  BebanPenyusutan Expense N-T Rp0.00
=  6-1400 DISKON Expense Rp0.00
= 61410  Diskon yang Diberikan Expense N-T R Rp0.00
o 6-1420  Diskon yang Diterima Expense M-T \/ Rp0.00
= 61500 Bebanluran Expense N-T Fp0.00
=  E16800  BebanInsuransi Expense N-T Rp0.00
= B-1700  Beban Denda Expense M-T ~ Rp0.00
=  E1800  BebanPemeliharaan & Perbaikan Expense N-T Rp0.00
© 61900  Beban Perlengkapan Kantor Expense M-T Rp0.00
= 6-2200 BEBAN PEGAWAI Expense Fp0.00
= 62210 Beban Fasilitas Pegawai Expense N-T Rp0.00
= 62220 Beban Gajik Upsh Expense NT | Ap0.00
= 62230  Beban Pegawai Lainnpa Expense N-T 0 Rp0.00
= B-2300  Beban Ongkos Pengiman Expense M-T Rp0.00
= B-2400  Beban Sewa Expense N-T Rp0.00
=  B-2500  Beban Air dan Listrik Expense N-T Rp0.00
= B-2600  Behan Parjalanan & Hiburan Expense N-T Rp0.00
= 62700 SERVICE Expense Rp0.00
o 6-2710  BebanGas Expense M-T Rp0.00
= 62720 Beban Listrik. Expense N-T Rp0.00
= 62720  BebanAir Expense N-T Rp0.00
= 8-0000 PENDAPATAN LAINNYA Other Income Fp0.00
= 81000 Pendapatan Lainnga Other Income N-T Rp0.00
= 9-0000 BEBAN LAINNYA Other Expense Rp0.00
= 51000  BebanBunga Other Expense N-T F\pﬂ,ﬂﬂ_{
= 592000 Beban Pajak Penghasilan [PPH) Other Expense M-T Rp0.00 >

Gambar 8. Hasil Import Akun

MYOB memiliki 8 menu Command Centre. Berikut dijelaskan fungsi
fitur yang sering digunakan di setiap menu Command Centre :
a. Accounts

(&) PT RADIV ANUGRAH PROPERTINDO - Cammand Centre

[mvos] ACCOUNTS
& s 5 5 ]
> - ‘
- — ’ . 7 o L
Accounts Banking Sales TimeBiling  Purchases Payrall Inwentorp Card File
Send to Accountant & @ BASlink
-- MoneyController .. &
: : Record Journal Entry @ Company Data Auditor
- Transfer Money -+
& M-Pgwered
S
@ Transaction Journal ¢ (%g\;"ltcs
ToDolist - Find Transactions w Reports w Analysis w

Gambar 8. Sub Menu Accounts

1) Account List : Untuk melihat/menambah/mengubah/menghapus
daftar akun — akun perusahaan.

2) Record Journal Entry : Untuk mencatat transaksi jurnal umum
dan jurnal penyesuaian.

3) Transaction Journal : Untuk melihat transaksi jurnal yang dibuat
melalui Accounts.

b. Banking
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(] PTRADIV ANUGRAH PROPERTINDO - Command Centre =2 E=R ==
(mvos] BANKING ?
> -, | e 4 1 L
| & ] e ) — iy = 2 y
m | | 2= ) i - iy
- e e ~ / L -
Accounts Banking Sales Time Biling Purchases Payrall Inventony Card File
-- Bank Register ----ooooeees  Receive Money
Ld : :
.. Prepare Elecironic Payments .. & &
: : RFeconcile Accounts Prepare Bank Deposit
-+ Print Chegues -t :
L4 & M-powered
PrintEmail Remitance Advices @ Transaction Journal Services
(‘ Centre
ToDolist - Find Transactions Reports » Analysis »

Gambar 9. Tampilan Sub Menu Banking

1) Spend Money : Untuk mencatat transaksi pengeluaran kas dari
bank guna keperluan usaha dan pelunasan hutang. Transaksi
yang dicatat, seperti pembelian perlengkapan, membayar beban -
beban dan lain — lain.

2) Bank Register : Untuk melihat mutasi setiap kas di bank dan
dapat menambahkan transaksi perbankan.

3) Receive Money : Untuk mencatat transaksi penerimaan kas.
Transaksi yang dicatat seperti, penerimaan setoran modal,
pendapatan bunga dari bank, penjualan aktiva dan lain - lain
selain pelunasan piutang dari pelanggan.

4) Print Cheque : Untuk mencetak cek yang telah dibuat.

5) Reconcille Account : Untuk melakukan rekonsiliasi bank secara
manual, seperti rekonsiliasi kas/bank, piutang dagang dan
hutang dagang.

6) Prepare Bank Deposit : Untuk mencatat proses pencairan cek/giro
yang diterima dari pelanggan atau card lainnya.

7) Transaction Journal : Untuk melihat transaksi jurnal yang dibuat
melalui banking.

c. Sales
(5] PTRADIV ANUGRAH PROPERTINDO - Command Centre =Nl =<
fwvos] SALES 9
> > H 1 =Y
r‘?m S =] & o
~ Z : I
Accounts Banking Time Biling Purchases Payroll Inventory Cad File
Sales Register
Enter Sales @:Receive Payments
& &
PrinyEmail Statements « Print/Email Invoices Print Receipts
& 1-Powered €
Transaction Journal « Services
€) Centre
ToDaoList » Find Transactions w» Reports w Analysis w

Gambar 10. Tampilan Sub Menu Sales
1) Sales Register : Untuk melihat daftar transaksi penjualan.
2) Enter Sales : Untuk mencatat transaksi penjualan.
3) Receive Payments : Untuk mencatat transaksi penerimaan
piutang.
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4) Transaction Journal : Untuk melihat transaksi jurnal yang dibuat

melalui Sales.
d. Purchases

(] PT RADIV ANUGRAH PROPERTINDO - Command Centre E=n EoR ===
[MYOB] PURCHASES 9
) S ke o8
W2 o
Accounts Banking Salex Tm’;a Ewlhn.g Purchases Payral Iwventony C-a-rd File
{Purchases Register |
&
Pay Bills & «oooooveeveiaieies Enter Purchases
& :
L3

Frepare Electronic Payments ..
: BrintEmail Purchase Orders

Frint Cheques

e i M-Powered (]
FrinyEmail Remitance Advices @ Transaction Journal Ps St.?mtcs
entre
ToDoList - Find Transactions w Reports w Analysis w

Gambar 11. Tampilan Sub Menu Purchase
1) Purchase Register : Untuk melihat daftar transaksi pembelian.
2) Enter Purchase : Untuk mencatat transaksi pembelian.
3) Pay Bills : Untuk mencatat transaksi pembayaran utang.
4) Transaction Journal : Untuk melihat transaksi jurnal yang dibuat
melalui Purchase.
e. Inventory

(5] PTRADIV ANUGRAH PROPERTINDO - Command Centre E-@
=
. ] -, | b o
- g o iz A |
\ ”J z & 7
W>mbEDPE }%
Accounts Banking Sales Time Billing Purchagzes Fayloll Inventory Card File
Eul\d\tems Trsssssensiasencriens ftems Register oo Adjust Inventan:
& & &
Auto-Build Rems <coooeiiiiiii « Hems List «cooceceriiiniiiiii Set ltem Prices
& &
Beceive tems Count Inventary
® M-powered €1
Transaction Journal Services
€) centre
ToDolList - Find Transactions w Feports Analysis w

Gambar 12. Tampilan Sub Menu Inventory
1) Item Register : Untuk melihat daftar transaksi persediaan.
2) Item List : Untuk melihat daftar persediaan.
3) Adjust Inventory : Untuk penyesuaian persediaan.
4) Transaction Journal : Untuk melihat transaksi jurnal yang dibuat
melalui Inventory.

f. Card File
Card List : Mengisi daftar kartu nama dengan tipe Customer,

Supplier, Employee dan Personal.
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(i) PTRADIV ANUGRAH PROPERTINDO - Command Centre o[5S

[mvoB] CARD FILE 9

" > == — - . N
Ol S 5 B b |2
Wi gy T D e
Accounts Banking Sales Time Biling Purchases Payrall Inventary Card File

Contact Log
&
Print Mailing Labels
& 1-Powered €
Create Personalised Letters Services
(, Centre
ToDoList » Find Transactions v Reports w» Analysis w

Gambar 13. Tampilan Sub Menu Card File
4) Mengatur Akun
Langkah pertama dalam membuat daftar akun yaitu dengan
mengimport akun yang sudah di list di Notepad sebelumnya. Kemudian
tahap berikutnya adalah mengatur akun. Adapun langkah - langkahnya
yaitu :
a. Mengedit Akun

— Al

All

Acaounts | (&) Edit Accounts [ ]
A Profile Details Banking History

3 1-0000/ N I I I

& 14 1-1130  New Account Currert Balance o Fp0.00

o 1

3 " Header Account I™ Inactive Account

4 @

= Detail Account

o

o Account Classification: Asset

3 Account Type: [ Dther Asset e

2 Account Number. 1- [1130

& 1 Aocount Name: [Fas Setara kas

3 1 Opening Balance: [Fp0.00

3 1

L

8-
Help Fi

A

v
Help F1 Hew Budgets

Gambar 14. Langkah - Langkah Mengedit Akun
Akun yang terdapat di account list dapat di edit dengan
langkah — langkah sebagai berikut :
1) Klik Accounts > Klik panah pada akun yang akan diedit.
2) Edit tipe akun, nomor akun dan nama akun > Ok.
b. Menghapus Akun
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(& MYOE Accounting
File Edit Lists Command Centres Setup Reports Window Help

cut Crlex == ]

Copy Ctrl+C

Paste Crl+V = (B = }
Clear EI@
Delete Account

Curent Balsnce [ Rp000

[ Inactive Account

ification: Asset

n Type: [Bank — =
Humber: 1 - [{EX

‘Name: [CashDrawer

3alance: [Rp0,00

z b
ACIE
Help F1 HNew Budgets

Gambar 15. Langkah - Langkah Menghapus Akun
Klik panah pada akun yang akan dihapus > Klik edit pada toolbar
MYOB atau klik kanan pada tampilan akun tersebut > Delete
Account.
c. Menambah Akun

[

E] Accounts List EI@

LA I fgset I Liabilty I E ity I Income I C;;‘egf — IEC";;; EED-“;;B
Account Name Type Tax Linked Balance

410000 ASET  |Asset R0, 00
& 1-1000 ASET LANCAR Fipl.00
= 1-1100 KAS SETARA KAS Rpl.0f
(=3 11110 Kas diBank Rp0.00
= 11130 Kas Setara Kas Other Asset Rp0.00
=3 11140 Kas Kecil Bank Fip0,00
=3 11200 Piutang Usaha Accounts Receivable Fip0.00
=] 11300 Insuransi Other Asgzet Rp0,00
5 1-2000 Aset Lainnya Asset Fip0.00
= 1-2300  Pembayaran Dimuka DOther Asset Rp0,00
= 1-3400 PERALATAN KANTOR Asset Rp0,00
=] 1-3410  Peralatan Kantor Other Asset Rp0,00
o 1-3420  Akum. Dep. Peralatan Kanbar Other Asgzet Rp0,00 *

b
=
©

| g Down

| B8 Combine Accounis

g~
Help Fi Budgets

Gambar 16. Langkah - Langkah Menambah Akun
Klik New > Tentukan jenis akun > Tentukan tipe akun > Isi nomor
akun > Isi nama akun > Ok.
d. Memindahkan Linked Akun
Linked akun adalah akun yang terhubung dikode pajak dan
kode item barang. Akun yang sudah terhubung dengan linked akun
tidak akan bisa dihapus tetapi bisa dipindahkan. Berikut adalah
langkah - langkah yang dilakukan :
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A (B Edit Accounts =N o
I Profile I fisiaiis I Banking l History

11140  Kas Kecil

Current Balance £ Rp0,00

Description:

TaxCods : [N-T 5] Mot Reportable

Linked Account for & Undeposited Funds

;)/ uj

O d =
Help F1 Hew Budgets

Gambar 17. Langkah - Langkah Memindahkan Linked Akun
1) Pada menu Accounts List Klik tanda panah pada akun yang
memiliki linked akun.
2) Details > Klik panah Linked Accounts for > Pilih akun yang akan
di linked akun > Use Accounts > Yes.
e. Mengatur Saldo Awal

(&) MYOB Accounting
File Edit Lists Command Centres Setup Reports Window Help

& o =)=
(Y T Gpenmg Bafances =R 34
Enter the balance of your accounts as of 01/01/24 [Balance Sheet Oniy). .
(Remember, enter all balances as pasitive numbers, unlsss the balance really was neqative ) ey
’ _'\—.’:\
Acct # Name Opening Balance Cad File
Asset
11110 Cheque Account
1-1120 Payroll Cheque dccount Rp0.00
1-1130 Kas Setara Kas Rp0.00 aney
1-1140 Petty Cash Rp0.00
1-1150 Pravision Account Rp0.00
1-1160 Investment Account Rp0,00
1-1180 Undeposited Funds Rp0,00 .
1-1150 Electronic Clearing Account Hpl.00 Peposit
Amount [eft to be allocated: Rp0,00
This will be the Opening Balance of the Historical Balancing Account W-pPawered (
Services
,7/ Centre
-
Help F1 Analysis w

Gambar 18. Tampilan Account Opening Balances

1) Klik Setup pada toolbar MYOB > Klik Balances > Klik Account
Opening Balances.

2) Isi saldo awal dengan mengetikkan angka saldonya di setiap akun
yang bersangkutan.

3) Akun yang diisikan dengan nilai minus berupa saldo kontra
balance seperti akumuluasi penyusutan, potongan penjualan dan
retur penjualan.

4) Pastikan Amount left to be allocated Rp. 0,00 untuk
menyeimbangkan saldo > Klik Ok.

f. Mengatur Ketentuan Pajak
Setiap perusahaan yang sudah menjadi Pengusaha Kena Pajak
dan memiliki NPPKP (Nomor Pengukuhan Pengusaha Kena Pajak)
wajib memungut Pajak Pertambahan Nilai. PPN (Pajak Pertambahan

Nilai) yang berlaku pada saat laporan ini dibuat sebesar 11% dari

JKP (Jasa Kena Pajak). Tarif pajak tersebut dapat berubah sesuai
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dengan peraturan perpajakan yang berlaku, adapun langkah -
langkah untuk mengatur kode pajak adalah sebagai berikut :

(& MVOB Accounting
File Edit Lists Command Centres Setup Reports Window Help

= = £
(& = |[=][= 0]
4 [&] Tax Code Information EI@ -
q Tax Code Information ﬁ
Enter the tax cods [up to tres characters), a brisf description of the tas and the rate of tas =
Select an appropriate tax type and complete the links as necessary. Card Fil
Tax Code: |[SEH]
Description: | Pajsk Pertambahan Nilsi
Tax Type: |Goods & Services Tax =l
Rate: 1% "
itor
Linked Account for Tax Collected 2> | 21310 &l Pajak Penerimaan vered €
Linked Account for Tax Paid & | 21330 5 Pajak Pembayaran ::(r?
Linked Card for Tax Authority | =
nalysis W
E
New

Gambar 19. Tampilan Tax Code Information

1) Terdapat beberapa kode pajak yang su
Klik Lists pada toolbar MYOB > Tax
Code kecuali GST dan NT.

3)

Rate : 11%.

Linked Accounts for Tax Collected :

Linked Accounts for Tax Paid : Paja
4) Klik Ok.

Mengisi Card List

dah disediakan oleh MYOB.
Codes > Hapus semua Tax

Klik tanda panah Tax Code GST > Isi informasi sebagai berikut:
Description : Pajak Pertambahan Nilai.

Pajak Penerimaan.
k Pembayaran.

Card List adalah partner kerja di perusahaan seperti pemasok

(supplier) yang menyediakan barang dan

pelanggan (customer) yaitu

orang/badan usaha yang membeli barang/jasa yang kita jual. Card
list bisa disusun di MYOB, adapun langkah - langkahnya adalah

sebagai berikut :

Ei] Card Information

=~

Profile I Card Details ' Buying Details ' Payment Details IED

htact Lag ' Jobs ' Histary

Bachtiar 5-001

A/P Balance o Fp0.,00

Card Tppe: | Supplier - Designation: | Compary -
Name: |[EERE

™ Inactive Card

CardID: | 5-001

Ci

& Bint =3 Epal | B wepsie

7

o
Help F1

3 Letter

Location: | Address 1 =
Address: [JI. Raya Paseh No. 208 Phone#t1: | 081320397298
— Phone#i2: | 081287571343
City: | Sumedang Phone#i3:
State: | Jawa Bard  Postoode: Fere
Country: | Indonesia Email:

‘website:
Salutation:

ontact: | Siti Aispah

Gambar 20. Tampilan Profile Card Information
1) Klik Card File > Card List > Customer/Supplier > New > Isi profile

Customer/Supplier sebagai berikut :
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nlE
®

0

o

8

(8] Card Information [ E=SEeR ==

Profile Bl ' Payment Details ' Contact Log ' Johs ' Histary
Bachtiar 5001 AP Bdance Rp0.00

Card Details

Purchase Layout: [liem - Credi Linit: Rpl.00
Printed Form: = Avaiable Ciedit [ Ap000
Purchase Order Delivery: | To be Printed = Curently PastDue: [ Rp0.00
ABN
Expense Account | 51000 || Harga Pokok Perjualan ABN._ Branch:
Payment Meme: Tax ID Number:
Purchase Comment El Tan Code: PPN |5 Pajek Pertambahar
Shipping Methoc: = Frsight Tas Code: PPN ] Pajsk Petanibahar
Supplier Biling R ate: AP0 Excluding Tax B e Siats T Bl

Cost per Hour Rp0.00

— Supplier Terms Ifommation

Payment is Due: [In a Given # of Daps 3} 3 Discount for Early Payment: | 0%

Discount Days: [0
Balance Due Days: [0 Wolume Discount %: [0%

7

3w
Help F1

Gambar 21. Tampilan Buying Details Card Information
2) Buying Details > Isi informasi sebagai berikut :
- Purchase Layout : Item.
- Expense Account : Harga Pokok Penjualan.
- Payment is Due : In a Given # of Days.
h. Saldo Awal Card List

@ MYOEB Accounting
File Edit Lists Command Centres Setup Reports Window Help

Easy Setup Assistant

(E] PTRADIV ANUGRAH PRO Balances > Account Opening Balances i
m Linked Accounts > Job Opening Balances ?
Preferences Customer Balances
Bl S5 oo ) Swebes
b C X m ‘;“f‘g
Accounts Banking Companylifonnatio Payral Iventary Card File

Business Calendar

'Seﬂghj . Load Payroll Tax Tables S & BASlink

General Payroll Information

.. MoneyController ... s
: : Record Journal Entry @ Company Data Auditor
+ Transfer Money -+

& M-powered
........ Sarvices
@ Transaction Journal (, ol s
ToDaolist - Find Transactions w Fepots w Analysis w

Gambar 22. Langkah - Langkah Mengatur Saldo Awal Card List
1) Klik Setup pada toolbar MYOB > Klik Customer atau Supplier
Balance.
2) Klik tanda panah pada Customer/Supplier yang akan diisi saldo
awal > Add Sales/Purchase > Enter > Klik Record.
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[= | & sl

@ Historical Purchase

Historical Purchase

Supplier Name: |Bachtiar §| Balance: Rp0.00
Tems = Net

FO #: | 00000007

Date: | 01/01/24
Supplier Inv #:

M ema: | Saldo Awal Utang Dagang
Total Including Tax: | Rpl16.000.000,00 Tax Code: |M-T

Job: =

Tax cx Rp0.00

Help F1

Gambar 23. Tampilan Historical Purchase

i. Mengisi Inventory

Barang dan Jasa disebut sebagai item di MYOB. Item ini

digunakan sebagai kode untuk dibeli atau dijual, adapun langkah -
langkah untuk mengisi inventory yaitu sebagai berikut :

1)

2)

3)

o || & &R

.:.EISZ]—‘?

oo

%
{
I

Gambar 24. Tampilan Profile Item Information
Inventory > Items List > New > Isi informasi sebagai berikut :
a) Item Number : Nomor Item.
b) Name : Nama Item.
c) Ceklis (M) I buy This Item.
d) Expense Accounts for Tracking Costs : Harga Pokok Penjualan.
Buying Details > Isi informasi sebagai berikut :
a) Buying Unit of Measure : Pcs.
Klik Ok.

[&] ttem Information

Profile || lemDetsls | BuingDefal |  SelngDetais | Histow | Autobuid

I Ingstive ltem

¥ | Bup This ltem
™ | Sell This Item
I Irwentory This [tem

Expense Account for Tracking Costs =: [5-1000 =] Harga Pokok Penjuslan

05 Com M #egl Spel
17/' Llj

g
HelpF1 | New

j- Mengisi Saldo Awal Inventory

1)
2)
3)
4)
5)
6)
7)

8)
9)

Klik Inventory > Adjust Inventory > Isi Informasi sebagai berikut :
Date : Tanggal saldo awal periode.

Memo : Saldo awal barang dagang.

Item Number : Kode barang di inventory.

Quntity : Kuantitas.

Unit Cost : Harga beli satuan.

Amount : Nominal otomatis dari perkalian kuantitas dan harga
beli satuan.

Account : Akun yang digunakan (Persediaan).

Record.

k. Backup Data

Backup data MYOB adalah proses membuat salinan cadangan

dari file data utama untuk memastikan data aman dan dapat
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dipulihkan jika terjadi kehilangan data, kerusakan file dan lain - lain.
Berikut adalah langkah - langkah untuk melakukan backup data
MYOB yaitu :

@ MYOE Accounting
File Edit Lists Command Centres Setup Reports Window Help

Mew Ctrl+N
Open File Ctrl+0
Commmand Centre EI@
INVENTORY 9
Print... Ctrl+P
Print Setup... zm L >
Default Fonts... | ﬂ‘: '%
- ~ LA —
Back Up... 5 Time Billing Puichases Pagroll Inventony Card File
Restore...
Verify Company File... veeveienens teme Registar cooooeeoees Adjust Inventany
Optimise Company File : :
P pany P A L4
- -;\temsl:isté crrerrasreneeeeee e St fem Prices
Start a New Year > ps P
Import Data 5 Becewg lterms Count Inventary
Export Data » & H—P(_awgmd(_
AccountantLink > Transaction Journal Services
(‘ Centre
Exit
ToDolist Find Transactions w Reports w Analysis

Gambar 25. Langkah - Langkah Backup Data MYOB Accounting
Klik toolbar File > Klik Back Up > Klik Back up all data > Klik
Continue > Save file back up di File Explorer.
1. Keluar Aplikasi MYOB

@ MYOB Accounting
File Edit Lists Command Centres Setup Reports Window Help

New Ctrl+N
Open File Ctrl+0

Command Centre E@

INVENTORY 0

Print.. Ctrl+P
Print Setup... = - ? = L L
Default Fonts... y ¢

# &.._ . i 2
Back Up... s Time Billing Purchases Payrall Inventony Card File
Restore...

Verify Company File... oo ltems Register oo Adjust Inventory
Opti C Fil :
ptimise Company File o
.................. Satltem Prices

Start a New Year > @ &

Import Data 5 Beceive tems Count Inventary
Export Dat, >
port e N n-owered (]
Accountantlink > Transaction Journal Services
€)) Centre
Exit

‘ ToDaList » Find Transactions w Reports w Analysis

Gambar 26. Langkah - Langkah Keluar Aplikasi MYOB Accounting
Klik toolbar File > Klik Exit > Klik No.
b. Penyajian Laporan Keuangan
Setelah menyiapkan data awal seperti daftar akun, neraca saldo awal,
daftar item, card list, daftar pajak dan transaksi yang dilakukan. Tahap
selanjutnya adalah pembuatan laporan keuangan. Berikut adalah langkah —
langkah yang dilakukan :
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MoneyController &
Record Journal Entry
Transfer Money

&
@ Transaction Journal

(8] PTRADIV ANUGRAH PROPERTINDO - Command Centre =g BB <=
[myoB] ACCOUNTS 9
- T 1 7‘%1 !_ 1 2
Q> 5 B ) i 7
% L o
Accounts Banking Sales Time Billing Purchases Payroll Inventary Card File
Accounts List @ BASIink

2 Company Data Auditor

ToDolList w Find Transactions w

Reports w Analysis v

Gambar 27. Langkah - Langkah Menampilkan Laporan Keuangan

1. Menampilkan Laporan Neraca

a. Klik Report > Account > Balance Sheet > Standar Balance Sheet .
b. Klik kanan > Pilih periode yang akan ditampilkan.

c. Display.

PT RADIV ANUGRAH PROPERTINDO
Cluster Mekarsari Blok G Nomor 8 Rt/Rw 08/08 Desa Mekarjaya Kecamatan Sumedang U

Balance Sheet

As of 01/01/24
12/06/24
18.50.00

ASET

ASET TETAP
Total ASET
KEWAJIBAN

Net Assets

MODAL

Rp0,00

Rp0,00

Gambar 28. Tampilan Laporan Neraca

2. Menampilkan Laporan Laba Rugi

a. Klik Report > Account > Profit & Loss > Profit & Loss [Accrual].

b. Klik kanan > Pilih periode yang akan ditampilkan.
c. Display.

PT RADIV ANUGRAH PROPERTINDO
Cluster Mekarsari Blok G Nomor 8 RVRw 08/08 Desa Mekarjaya Kecamatan Sume

Profit & Loss Statement

January 2024 through December 2024
12/06/24
18.53.46

Pendapatan

HARGA POKOK PENJUALAN

Gross Profit Rp0,00
BEBAN

Operating Profit Rp0,00
PENDAPATAN LAINNYA

BEBAN LAINNYA

Net Profit / (Loss) Rp0,00

Gambar 29. Tampilan Laporan Laba Rugi
3. Menampilkan Laporan Arus Kas

a. Klik Report > Bankinng > Cheque and Deposit > Statement

Cashflow.
b. Klik kanan > Pilih periode yang akan ditampilkan.
c. Display.
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PT RADIV ANUGRAH PROPERTINDO
Cluster Mekarsari Blok G Nomor 8 RURw 08/08 Desa Mekarjaya Kecamatan Sume

Statement of Cash Flow

January 2024 through December 2024
12/06/24
18.57.42

Cash Flow from Operating Activities
Net Income Rp0,00
Net Cash Flows from Operating Activities - Rp0,00

Cash Flow from Investing Activities
Net Cash Flows from Investing Activities Rp0,00

Cash Flow from Financing Activities
Net Cash Flows from Financing Activities E— Rp0,00

Net Increase/Decrease for the period

)
Cash at the Beginning of the period Rp0,00
Cash at the End of the period — _ Rpo,u0

Gambar 30. Tampilan Laporan Arus Kas

KESIMPULAN

Berdasarkan hasil penelitian yang dilakukan, maka peneliti dapat
mengambil kesimpulan sebagai berikut :

1. Sistem pencatatan keuangan dan pembuatan laporan keuangan di PT Radiv
Anugrah Propertindo masih menggunakan sistem manual dengan Microsoft
Excel. Adapun langkah - langkah sistem pencatatan keuangan manual yaitu
sebagai berikut :

a. Mencatat transaksi ke jurnal pengeluaran kas

b. Memposting transaksi dari jurnal pengeluaran kas ke buku besar

c. Pengeluaran kas proyek yang sudah di posting ke buku besar di posting
kembali ke jurnal pengeluaran kas setiap proyek dengan lebih rinci dan
detail

d. Merekap laporan mingguan yang berisi saldo masuk dan pengeluaran kas
sesuai dengan kategorinya

e. Membuat laporan keuangan berupa arus kas secara manual yang datanya
berasal dari laporan mingguan yang sudah direkap sebelumnya.

2. Pencatatan transaksi keuangan menggunakan MYOB accounting jauh lebih
efektif dan efisien dibandingkan dengan sistem manual. Pada penelitian ini,
langkah untuk menyajikan laporan keuangan yaitu :

a. Mengatur data awal MYOB Accounting.
b. Mencatat setiap transaksi keuangan.

Kemudian MYOB akan memprosesnya secara otomatis yang dapat
membantu dalam mengurangi kesalahan pencatatan, mempercepat proses
penyusunan laporan keuangan dan memberikan informasi keuangan secara nyata
sehingga dapat membantu dalam pengambilan keputusan.

PT Radiv Anugrah Propertindo dapat memanfaatkan MYOB accounting
untuk meningkatkan efisiensi operasional dan memastikan kepatuhan terhadap
Standar Akuntansi Keuangan Entitas Privat (SAK EP). Dengan demikian,
perancangan komputer akuntansi berbasis MYOB accounting mampu menunjang
pembuatan laporan keuangan yang lebih akurat dan andal.
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